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An archaeological earthwork survey by LiDAR study for land off Leicester Road, 

Market Harborough, Leicestershire (SP 725 884) 

 

 

Matthew Beamish  

 

Summary 

An archaeological earthwork survey by LiDAR study has been prepared for 

Parkers of Leicester by University of Leicester Archaeological Services (ULAS) for 

land to the east of Leicester Road, Market Harborough, Leicestershire, (SP 725 

884). The survey was undertaken in advance of the proposed re-development of the 

site, which is currently under pasture.   

Previous desk-based assessments and geophysical survey (Hunt 2015; Slater 2015) 

identified the remains of well-preserved earthworks surviving from medieval ridge 

and furrow field systems. LiDAR analysis has further confirmed the survival of 

these earthworks and also identified those relating to a windmill known to have 

been extant in 1814. Some other elements of topography are discussed.  

The archive will be deposited with Leicestershire Museums as part of Accession 

Number X.A54.2015. 

Introduction 

In accordance with National Planning Policy Framework (NPPF), Section 12 (Conserving 

and Enhancing the Historic Environment) this document outlines the results of archaeological 

earthwork survey by LiDAR study for land off Leicester Road, Market Harborough, 

Leicestershire (SP 725 884). The assessment was commissioned by Parkers of Leicester Ltd 

from University of Leicester Archaeological Services (ULAS) in advance of the proposed 

development of the site. 

The site is currently a narrow pasture field of some 1.3ha lying at a height of between 110 

and 120m OD at the north-western edge of Market Harborough. The site contains visible 

ridge and furrow earthworks which have survived from medieval and possibly post-medieval 

field systems, and also the remains of a mill mound known to have survived until 1814 when 

recorded in an Ordnance Surveyors drawing (Figure 3). 

The Historic Environment Record for Leicestershire and Rutland indicates that there are 

several known sites containing prehistoric remains close to the site. Roman and medieval 

remains are also known from the vicinity of the site (Hunt 2015). 

The LiDAR study has been commissioned with the aim of enabling clear assessment of the 

significance of the earthwork features within and immediately adjacent to the site. 

Specifically it is intended to clarify the location and state of preservation of the mill mound, 

and the extent and survival of the ridge and furrow earthworks.  
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Figure 1: Site location 

 

Reproduced from the Landranger 140 Leicester area 1:50000 map by permission of Ordnance Survey on behalf 

of The Controller of Her Majesty’s Stationery Office. © Crown Copyright 1996.  All rights reserved.  Licence 

number AL 100029495 
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Figure 2: Location of proposed area west of Leicester Road with 1m resolution LiDAR 

Digital Terrain Model data used in the study, with ground height in metres AOD. 
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Figure 3: Extract of Ordnance Surveyor Henry Stevens drawing of Leicestershire, British 

Library, 1814. British Library, OSD 262. Original scale 2'' to 1 Mile (1:31680). Mill is 

arrowed 

 

 

Geophysical Survey 

 

A geophysical survey was undertaken for ULAS by Stratascan Ltd (Slater 2015). The survey 

identified north-south aligned ridge and furrow as the only probable archaeology (Figure 4, 

1), with two areas of possible archaeological responses in the north-eastern half of the survey 

(Figure 4, 2). A north –south field boundary that bisects the proposed area was also identified 

(Figure 4, 3). Magnetic disturbance from fencing around the proposed area (Figure 4, 4) 

probably prevented the identification of the windmill mound in the south-west of the area.  
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Figure 4: Interpretation of gradiometer anomalies from the geophysical survey (after Slater 

2015, Fig. 5) 

Aim of the Survey 

The overall aim of the survey was to accurately record the location and state of preservation 

of surviving earthwork features within and immediately adjacent to the site in order that their 

significance could be assessed. Specifically any surviving earthworks of the mill mound were 

to be clarified. 

Methodology 

Analysis based upon aerial LiDAR data was requested by Teresa Hawtin of Leicestershire 

County Council as archaeological planning advisor to Harborough District Council. 

Following a search of Environment Agency archived data, composite aerial LiDAR data at 

1m resolution was supplied electronically in ASCII file format by National Geomatics Unit 

of the Environment Agency. The area was flown and the data collected in February 2009: 

details of the data source are given below (p19). The data were acquired in DTM format, that 

has been filtered, where possible, to remove obstructions such as buildings and vegetation 
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and provide a 'bare-earth' model. If the removal of any obstruction left a gap in the surface 

data this gap was interpolated by the EA (using an undisclosed algorithm) to provide a 

continuous surface. 

The methodology used followed that set out by Hannon (Hannon et al 2014, 8) with some 

modification. 

LiDAR ASCII Data Processing 

Most operations were conducted in Esri ArcMap10.1 SP1 build 3143. The Relief 

Visualisation Toolbox which enables the rapid output of multiple hillshade, slope analysis, 

relief model and sky view analysis was also used (Zakšek et al. 2011; Kokal et al. 2011). 

Data files were imported into ArcGIS using the ASCII to Raster function (System 

Toolboxes>Conversion Tools>To Raster>ASCII to Raster), the output data type was set to 

‘Float’ and the original ASCII filename was retained as the output raster name. These files 

were placed in a newly created file geodatabase called ‘15710_MarketHarborough.gdb’.  

Creation of Hillshade layers 

To aid feature identification, four basic hillshade layers were generated for each LiDAR 

flight.  ‘Hillshades’ are a data processing method available in most GIS which allow an 

artificial sun to be shone from any chosen compass bearing and from angle above the horizon 

onto a DEM. This process helps identify ground features by casting an artificial shadow 

behind changes in elevation (for a full discussion of the process see Bewley et al 2005). 

Each of these layers were created using the hillshade function (System Toolboxes>Spatial 

Analyst Tools>Surface>Hillshade). The input raster for each hillshade was the DTM or the 

Clipped DEM if one was generated, for each LiDAR flight. Three basic parameters were 

utilised to generate the four different hillshade views and Z factor relating to the degree of 

exaggeration applied to the input DEM, with 1 indicating no exaggeration. 

Each output raster was named to preserve the original input DEM information and include the 

hillshade parameters (e.g.‘MH_1m_HS_315_45_1’) and saved to 

‘15710_MarketHarborough.gdb’. Once each hillshade was generated they were grouped 

within the TOC to aid navigation. 

Automatic multiple hillshade using the Relief Visualisation Toolbox (no of directions 16, sun 

elevation angle 30
o 

) were also created and saved to the Geodatabase 

(SP7288_DTM_1M1_MULTI_HS_D16_H30_RGB) 

Sky-View Factor Analysis  

‘Sky-View Factor’ (SVF) analysis was also applied to the LiDAR data (Zakšek et al 2011). 

This method, instead of applying false shadows to a surface, calculates the volume of sky 

visible from a given position, a position at the bottom of a ditch affords a lower level of 

visibility to one atop a mound. This method produces a raster layer showing the volume of 

sky visible from each position within the raster which can highlight subtle archaeological 

features. SVF is not a function available in ArcMap, therefore a free to use version of the tool 

is available online (http://iaps.zrc-sazu.si/index.php?q=en/svf). 

To utilise the tool the DEM for the area was exported as a TIFF. This was achieved by right-

clicking on the DEM layer within the TOC (Data>Export Data) selecting a destination for the 

http://iaps.zrc-sazu.si/index.php?q=en/svf
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TIFF file and leaving all other parameters at default. Once the TIFF had been exported the 

SVF tool was run. The exported TIFF was used as the input DEM and Search Radius was left 

at the default 10. The Vertical exaggeration was set to either 1, 2 or 3 and Direction set to 

either 16 or 32, multiple Sky-Views were run for each focus area using a range of values. The 

tool created an output TIFF file which reflected the name of the input DEM and settings used 

(e.g. ‘LiDAR_1m_SVF_d32_r10_ve3’). This TIFF was then imported into ArcMap and 

added to the TOC. 

The SVF images were then also interrogated and potential features recorded in the same 

manner as is detailed above for the initial feature identification process. 

Feature Identification 

The hillshade layers that had been generated were systematically analysed for potential 

archaeological features, working from north to south and west to east. This was achieved by 

working through each of the hillshade and Sky View Factor layers individually. The shapefile 

layers containing both the HER and scheduled monument data were enabled to prevent re-

identification of an already recorded archaeological feature.  

Once the areas of ridge and furrow within the study area had been identified as part of the 

LiDAR analysis, the hillshade plots that contained the clearest representations of the different 

elements were combined using varying transparencies to produce figures contained in this 

report. 

Profiles 

Profiles were generated with ARCGIS from the DTM data using the 3d Analyst tool, 

Interpolate line, choosing the profile line and Profile Graph options.  

Images were processed in Standard Raster image and CAD packages. 

Results 

Ridge and furrow at between 5m and 7m spacing is present on a north-south alignment across 

most of the proposed area. To the west, the alignment of the ridge and furrow is west to east, 

and this was influenced by the steep west and south-west facing slope, with the plough being 

pulled down rather than across the contour (see Figure 13).  

 

The ridge and furrow survives to an amplitude of some 40cm, The survival is weakest in the 

south-west of the proposed area. 

 

There is no clear relationship between the mill mound and the ridge and furrow, although a 

feature on the north side of the mound appears to truncate the ridge and furrow of both 

systems. There is no clear indication that the west-east ridge and furrow continued to the 

south of the mill mound.  

 

The mill mound which is some 20m in diameter is located at the south-western end of a broad 

ridge, just below the apex. The ridge and furrow to the north of the mound on the apex sits 

somewhat higher: the mound in north-south profile appears more as a levelled area than a 

construction, although in west–east profile a mound is very clear particularly with vertically 

exaggerated scale  (Figure 7 & Figure 9, A & B). 
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On the northern and eastern side of the mound is a weak linear feature between 4 and 7m 

wide and up to 70m long, which appears to post-date the ridge and furrow. The feature is 

represented by a slight levelling of the ground, and not by a clear cut (Figure 7 & Figure 9, 

C). The presence of the feature is indicated strongly in shade computations (e.g. Figure 5), 

but it is barely perceptible in elevation data DEM plots (Figure 11). The feature is sharply 

defined on the immediate north side of the mound (Figure 6) where it curves around the edge 

of the mound and then terminates, so separating the mound from the ridge to the north. To the 

east the feature is more irregular. The feature terminates in the south-east at the proposed site 

boundary and is subsequently lost to modern development. 

 

A field boundary parallel with the north-south ridge and furrow can be identified (Figure 6). 

This boundary appears first on the 1984 mapping – it was not mapped in 1929 (Hunt 2015, 

Figure 8) 

 

Some 40m to the north of the mill mound, an area 17m long by 11m wide has been disturbed 

by a negative feature (Figure 8). The feature lies in the plough headlands where the north-

south and east-west furlongs meet and is shown in profile (Figure 8, E, F)  

Discussion 

At between 5m and 7m centres the ridge and furrow identified in the proposed area is of 

broad rig character and is probably of medieval date. Ridge and furrow spaced at less than 

5m centres is termed narrow rig and has been shown to be of later post-medieval date. Broad 

rig is thought to have been formed by the Ox drawn plough, and Narrow rig by horses. 

Narrow rig in places may relate to cultivation of new land in the Napoleonic period when 

pressure for domestic grain production increased.  

 

The mill site clearly survives and is bisected by the proposed site boundary. A 3d 

visualisation shows the mill site to be located above south and west facing slopes at the 

south-western end of a broad ridge which skirts the north side of Market Harborough (Figure 

13). A mill in this location was well exposed to south-westerly winds. 

 

The linear feature identified crossing the proposed area and terminating on the north side of 

the mill mound was partly surveyed on the 1886 Ordnance Survey map as a line abruptly 

terminating to the immediate north-east of the mill which was by this stage no longer shown 

(Figure 12). Arguably this line was also recorded on the 1814 drawing (Figure 3). At the time 

of geophysical survey in 2015, the area covering the south-eastern end of the feature was too 

vegetated to allow recording, although the feature was not identifiable in the survey data to 

the north. 

 

The linear feature at its western end where it separates the mound from the ridge behind, 

might be interpreted as evidence of a quarry for the mound material. Equally, the concentric 

shape of the linear feature might indicate that the feature was used in the mill’s life for a tail 

pole – the wooden pole extending from a post or tower/cap mill structure on the opposite side 

of the sails allowing the mill to be turned into, and out of, the wind (cf Thomas 2009, 117).  
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Figure 5: Hillshade plot of LiDAR 1m DTM data (Azimuth 45, Elevation 30 Vertical 

exaggeration 2) 
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Figure 6: Multiple hillshade plot. Location of Profiles A-F. The dashed line field boundary is 

20th Century in date (cf Hunt 2015, Figure 8). 
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Figure 7: Profiles A, B and C with dimensions at uniform scale (vertical exaggeration x6.5). 
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Figure 8: Profiles D, E and Fat uniform scale (vertical exaggeration x6.5). 
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Figure 9: Profiles A-D at uniform scale (no vertical exaggeration) 
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Figure 10: SkyView Factor shade plot with interpreted LiDAR features 
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Figure 11: Coloured Digital Elevation Model (DEM) of LiDAR data. Although giving some 

indication of mill mound and ridge and furrow, the limitation of such a plot compared with a 

shade or sky view plot is clear. 

 

 

 

 

 

 



An archaeological earthwork survey by LiDAR study for land off Leicester Road, Market Harborough, 

Leicestershire (SP 725 884) 

16 
© ULAS Report 2015-089 Accession Number X.A54.2015 

 

Figure 12: Left - extract of 1886 Ordnance Survey 1:2500 County Series (after Hunt 2015) 

and right, Results of Geophysical Survey (after Slater 2015), both with interpreted Lidar 

features 

 

 

  

 

The linear feature may simply represent an enclosure field boundary that post-dated the ridge 

and furrow although the abrupt termination of the line on the 1886 mapping makes this seem 

unlikely. Alternatively, the feature might represent the remains of a trackway that served the 

mill.  

 

The canal serving Market Harborough was constructed in 1809 following Act of Parliament 

in 1793. Originally intended to continue through to Northampton and therefore provide a 

direct canal link between Leicester and Northampton, the canal terminated at a wharf on the 

north side of Market Harborough and was never extended. The wharf is now integrated into 

the urban spread of the town (Union Wharf, Figure 2). Both wharf and mill were surveyed on 

the 1814 Ordnance Survey drawing of Leicestershire (British Library OSD 262, Burton 

Overy) and are proved to have some contemporaneity.  
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Figure 13: 3d visualisation facing east using Sky View Factor shade plot at x2 vertical 

exaggeration with proposed area in red, and interpreted features in blue. The mill mound 

occupies the south-western end of a ridge above a west and south facing slope. A linear 

feature running away from the mill to the east may represent a track way serving the mill. 

Conclusion 

The LiDAR study has indicated the survival of historic landscape features from medieval and 

post-medieval period within the proposed area. The mill mound survives and partly lies 

within the proposed site area. There is some indication that the mill mound was constructed 

by the levelling and mounding of an area at the end of a ridge, and also that the mill used a 

tail pole.  

 

There is some indication that the ridge and furrow is of medieval origin, and that the mill was 

located on the very edge of two field systems. The ridge and furrow of both field systems has 

been has been truncated by a linear feature that may relate to the mill’s use. At normal scale 

(Figure 9) the ridge and furrow is not significantly pronounced. 

Archive 

The archive will be deposited as part of X.A54.2015 and consists of: 

This report, 

1 GIS project in mxd format containing the layers created for the analysis. 
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The EA LiDAR data and images derived from that data have been used under Licence from 

the EA, and are not included in an archive deposition. 

 

 

Figure 14: Extract of Ordnance Surveyor Henry Stevens’ drawing of Leicestershire, British 

Library, 1814. British Library, OSD 262. Original scale 2'' to 1 Mile (1:31680) with 

proposed area in red. 
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Appendix: LiDAR metadata  

FILENAME TILENAME DATE_FLOWN %_COVERAGE POLYGON_ID RESOLUTION 

(m) 

D0116891 SP7288 16-21 Feb 2009 75 P_6235 1 
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